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Chapter 1

MegaBook

1.1 MegaBook Version 3.2 Documentation Contents

MegaBook Version 3.2
By Tom Bampton

©~1996 Eden Software

Section 1 - Introduction

~1.1~Introduction~~~~~~~~~

~1.2~System~Requirements~~

~1.3~Legal~Stuff~~~~~~~~~~

~1.4~Registration~(Free!)~

~1.5~Distribution~~~~~~~~~

1.6 Installation

~1.7~Using~This~Guide~~~~~

1.8 Release Notes
Section 2 - Useage

~2.1~~The~First~Time~~~~~~

~2.2~~The~Windows~~~~~~~~~

~2.3~~Records~~~~~~~~~~~~~

~2.4~~Navigation~~~~~~~~~~

~2.5~~Loading~~~~~~~~~~~~~

~2.6~~Saving~~~~~~~~~~~~~~
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~2.7~~Searching~~~~~~~~~~~

~2.8~~Printing~~~~~~~~~~~~

~2.9~~Preferences~~~~~~~~~

~2.10~Menus~~~~~~~~~~~~~~~
Section 3 - ARexx

~3.2~Database~Commands~~~~

~3.2~Requester~Commands~~~

~3.3~Example~Scripts~~~~~~

3.4 Writing scripts

3.5 Special Scripts
Section 4 - Extras

~4.1~Introduction~~~~~~~~~

~4.2~Voice~Dialing~~~~~~~~

~4.3~Data~Dialing~~~~~~~~~

~4.4~Sending~Faxes~~~~~~~~

~4.5~Sending~EMails~~~~~~~

~4.6~Extras~Storage~~~~~~~

4.7 Writing scripts
Section 5 - Credits and Contacts

~5.1~Credits~~~~~~~~~~~~~~

~5.2~Contacts~~~~~~~~~~~~~

~5.3~Eden~Software~~~~~~~~
Section 6 - Just for fun

6.1 READ THIS!

1.2 1.1 Introduction

MegaBook 3 is a very fast and powerfull Address Book program. It has been
designed to be simple to use yet extremely powerfull and flexible whilst
still being fast. We doubt you’ll ever need this guide file but some things
will need explaining, such as the extras and ARexx port.
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MegaBook also comes with 24 hour support via EMail or one of our BBS’s.
As an added bonus, registration is FREE! In fact, you don’t have to register
at all but all it takes is a quick EMail message so we’d like it if you did
and it will enable us to make it much better!

MegaBook 3.2 is a taste of MegaBook 4.0, tons more features are planned for
this already feature packed package.

1.3 1.2 System Requirements

MegaBook 3 requires OS 2.04+ to run. There is 2 versions of it, a standard
one which will run on any processor and a 68020+ optimised one.

You’ll also need reqtools.library in libs: and rexxsys.library if you want
to use ARexx (more or less required if you want to use the extras). You’ll
also need RexxMast running.

1.4 1.3 Legal Stuff

DISCLAIMER

You use MegaBook at your own risk. Neither I or any other member of Eden
will be held liable for any damages caused acidentally or otherwise. It is
provided ’as is’ with no warranties of any kind.

1.5 1.4 Registration

Registering MegaBook is fast and above all FREE!

You can use the supplied ARexx script (RegisterMegaBook.mbrx) to create the
application form to send to me. If you have Yam, it will use that to send the
application form to me. If you don’t have Yam, the script will make a text
file which you should either upload to my BBS or send it via EMail using your
mailer. The EMail address to send your completed forms to is
tombampton@dvalley.demon.co.uk. Make sure the subject is ’Register MegaBook’
minus the quotes. The registration process is completely automatic and you
will get a reply as soon as the mail has been procesed.

MegaBook 3.2 will probably be the last free version. Version 4 will be a
major enhancement and will probably be full shareware. It wont cost much but
registered users of 3.2 will get a discount, yet to be decided as a price
hasn’t been set for Version 4 yet. A free demo of Version 4 will be available
soon.

1.6 1.5 Distribution
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MegaBook may be freely distributed as long as no files are removed or
changed in any way. You may not charge more then the cost of media and
postage for MegaBook.

1.7 1.6 Installation

MegaBook v3 is very easy to install through the Install script ←↩
provided.

You’ll need a copy of Installer which hasn’t been supplied here because of
its size. You can obtain the latest version from the Aminet or you can find
it on your Workbench install disk.

The installer is quite easy to use but may need a bit of explaining. Help
is available at all times during the installation process.

If you have a modem, you’ll be able to use the powerfull extras system in
MegaBook (even if you dont, you can still use some of it).

The installer will automatically setup the system for you by copying the
correct scripts for your software. See section

4.1
for more information.

1.8 1.7 Using This Guide

This guide has been organised into sections to make it easier to use. Simply
scroll down to the section you want and click on the link to the subject you
want. There, simple.

Even if you don’t read the ’Useage’ section, please read the ’Extras’
section as it contains vital information to customizing the Extras to your
liking.

1.9 1.8 Release Notes

MegaBook 3.2 is a minor bugfix to 3.1 with some new features too.

NOTE: You _MUST_ use the samples in this archive for voice dialing as the old
ones had an extra chunk which _CRASHES_ MegaBook’s sample playing code!

New Features

o All (i hope!) bugs now fixed

o Iconfy window can now be snapshotted

o A couple more ARexx commands have been added

o Voice dialing is now completely internal, no need for that external sample
player now.
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1.10 2.1 The First Time

The first time you run MegaBook 3, it is likely you wont have a prefs file.
MegaBook will inform you of this and ask you if you want to create one. If
not, the defaults will be used and you’ll have to save the prefs yourself.

After the prefs have been saved (either by MegaBook or by selecting the
’Save Prefs’ menu option) you should immediately customize it with the Prefs
window. Even if you don’t change anything, you should change the sample
player otherwise voice dialing wont work (unless you have the default that
is)

1.11 2.2 The Windows

MegaBook is divided into 3 main windows. The Edit Window, List Window and
Tool Window.

The Tool Window is the main one which allows creation of records amongst
other vital functions.

The Edit window is where the records are displayed and where you edit them.
It also allows creation and deletion of records.

The List window simply shows a list of all the names in the database. You
can click on one to jump straight to that record.

1.12 2.3 Records

The records are the main part of the database. You can create them with
the Add gadget in the Edit window or using the Add menu item in the Records
menu. When you create a record, you’ll get most of the fields filled in with
defaults, telling you what you should put in them. The bottom 2 fields are
unique in MegaBook. They allow a selectable name from the cycle gadget at
the side of them. They also allow the Extras to decide what you have in
them. You have a choice of Tel, Fax, Home, Work, Email and Data for both of
the fields.

You can delete records using the Del gadget in the Edit window or the Del
menu item in the Records menu. You will be prompted to confirm the action
before MegaBook deletes the record.

1.13 2.4 Navigation

Navigation within the database is simplicity itself. You can use the Next,
Prev, First, Last or Goto items from the Record or Search menu or use the
gadgets on the Tool window. Alternatively, you can click on the name of the
entry in the List window to jump straight to that entry.
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1.14 2.5 Loading

To load a pre-saved database, either select the Open menu item from the
Project menu or click on the Load gadget on the Tool window. A file selector
will open and you can select the file to load.

There is an alternative way to load databases from the Workbench. If you
have Create Icons selected in the Prefs, an icon will be created for you.
If you double click on this, MegaBook will be run and the file loaded. Also
files can when running MegaBook by selecting the project icon and holding
down the shift key then double clicking on the MegaBook icon.

1.15 2.6 Saving

Saving is the same as Loading except you click on Save. If you want to save
the file under a new name, select Save As.. from the project menu. The Save
button on the Tool window is equivalent to Save As. To save the file under
the same name, select the Save item from the Project menu.

NOTE: The Save item from the Project menu DOES NOT work when the file loaded
was opened by double clicking on a project icon or shift-select when loading
MegaBook.

1.16 2.7 Searching

Select the Find menu item from the Search menu or click on the Find gadget
on the Tool window. This will open a Find requester (NOTE: while the find
requester is open, you can still use the rest of MegaBook!)

Enter the text you want to find into the Find string gadget then select you
find options. When checked, Case Sensitive will make the search case
sensitive. It defaults to Off. You can search in reverse by unchecking the
Forwards checkbox.

When done, click on Find.

You can leave the Find window open if you like and just click on Close or
the closegadget when you’ve finished with it.

1.17 2.8 Printing

Click on the Print gadget or select Print from the Project menu to open the
Print requester.

You can omit fields from the print by unchecking the corresponding checkbox
gadget. NOTE: Phone refers to the first selectable field and Fax refers to
the second.

You can also select which records you want printing by setting the MX gadget
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to either All or Range. If you want a range of records, enter it into the
First and Last gadgets. These by default contain the First and Last record
numbers but you may change them to suit your needs. If you enter an out of
range number, it doesn’t matter as MegaBook will recognise this and correct
it for you. It will also flash the screen to warn you of the changes. Note
that this only happens if Return or Tab is pressed in the gadgets but it
will still only print within the range if it detects an out of range number
at print time.

If you dont want to print afterall, select Cancel else click on Print and
the records you selected will be printed.

1.18 2.9 Preferences

From the Prefs window, you can alter a number of ways MegaBook looks.

You can have it open on it’s own screen or on the Workbench screen. If
Open on Workbench is checked, the Screen Mode gadget will be ghosted to stop
you using it. If you want your own screen, click on the Screen Mode button
and select your screen mode.

If Create Icons for data files is selected, MegaBook will make an icon for
each datafile. If the file ENV:MegaBook/def_project.info exists, it will
use that icon otherwise it will use its own internal default.

Click on the Sample Player gadget to select the sample player used when
voice dialing. The text box next to it will show your selection. Dont worry
if you cant see it all, it will be stored in memory OK.

NOTE: It is vital that you change this from the defaults if you wish to use
voice dialing.

When you save the prefs, the windows are automatically snapshotted.

1.19 2.10 Menus

Project

New Start a new database
~~~~~~~~~~~
Open O Open a database
Save S Save the current database
Save As V Save the current database under a different name
~~~~~~~~~~~
Print P Open the print requester
~~~~~~~~~~~
About ? Display information on MegaBook
~~~~~~~~~~~
Quit Q Quit MegaBook

Search
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Find F Open the Find requester
~~~~~~~~~~~
First < Goto first record
Last > Goto last record

Record

Add A Add a record
Del D Delete current record
~~~~~~~~~~~
Next . Goto next record
Prev , Goto previous record
~~~~~~~~~~~
Goto G Opens Goto requester

Prefs

Prefs R Opens prefs window
~~~~~~~~~~~
Save Prefs Save default prefs
Save Prefs As Save prefs under a different name
Load Prefs Load a prefs file
Last Saved Load default prefs file

Extras <See the Extras Section>

Execute Rexx E Execute an ARexx script
~~~~~~~~~~~
Dial Voice N Dial a voice number
Dial Data T Dial a data number
Send Fax X Send a fax
Send EMail M Send an EMail

1.20 3.2 Database Commands

FIRST, LAST, NEXT, PREV

As they say, they jump about the database.

DEL_ENTRY [no_confirm]

Delete current entry

ADD_ENTRY

Adds a record. You can change its contents with PUT_ENTRY.

NEW [no_confirm]

Create new project, removing current one

OPEN [file]

Open a new project. If file isn’t specified then a file requester will
pop up and the user must specify a file. Requesters will NOT appear when



MegaBook 9 / 16

loading a file thru ARexx apart from when you don’t specify a file. You
can not merge files when opening a file by specifying a name from the
script.

MERGE <file>

Same as Open but adds the file to the end of the project. This was added
because of the lack of Merge in the OPEN command when specifying a file.
Merge WONT open a file requester when used with no arguments, it will just
return 5. If you want a file requester for the merge, use OPEN with no
args instead. Requesters wont appear with the MERGE command either.

SAVE

Save current project

SAVEAS [file]

Saves project under a different name, if file isn’t specified then a
requester will pop up.

FIND <string>

Searches for string in project. RC will be 0 on success and 5 on failure.

GET_ENTRY <field>

Gets data from the current entry. Field is one of:

1: Name
2: Address
3: The blank field
4: Town
5: County
6: Postcode
7: Fone number (may be different, depends on cycle gadget)
8: Fax number (may be different, depends on cycle gadget)

RC will always equal 0 with this. result will contain the contents of the
requested field.

PUT_ENTRY <field> <text>

Changes the data in the current entry. field is a number from above and
text is the string to change it to.

SET_TYPE <field> <type>

Sets the type of the selectable fields. field is either 1 or 2. 1 is the
first, 2 is the second. type is one of:

1: Tel
2: Fax
3: Home
4: Work
5: EMail
6: Data
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GET_TYPE <field>

Gets the type of the selectable fields. field is either 1 or 2. 1 is the
first, 2 is the second. Returns in RC a number as above for Set_Type.

PRINT <text>

Sends text to the printer.

GETNUMRECS

Get number of records. Number returned in RC

GOTO <num>

Goto record. <num> is the number.

1.21 3.2 Requester Commands

SELECTFILE <title>

Brings up a file requester. <title> is the title for the requester. On
return, RC will be 0 and RESULT will contain the path and filename of the
file selected.

REQUEST <prompt> GADS <gadgets>

Brings up a requester. <prompt> is what the text is, <gadgets> is the
gadget format. i.e. ’Ok|Cancel’. Each gadget name is seperated by a |.
If you put an underline (_) before a char, that one will be underlined and
can be selected by pressing that button. RC will equal the number of the
gadget selected. 0 for the rightmost one, and numbered from 1 - n for the
leftmost to rightmost - 1.

GETSTRING <prompt>

Brings up a string requester.
On return, RC will equal 0 or 5 if the user canceled. RESULT will contain
the string.

1.22 3.3 Example Scripts

In the MegaBook3:Rexx drawer, you’ll find the ARexx examples. At the time
of writing this guide, we don’t know what they are going to be yet!

1.23 3.4 Writing your own scripts
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All MegaBook scripts should start with the following. This will run MegaBook
if it isn’t already running and wait for the ARexx port to become available.

--------- cut -------------------------------------------------------------
/*
** Comment (Required by ARexx)

*/

/*
The path to MegaBook in case it isn’t running

*/
MegaBookPath = ’MegaBook3:MegaBook’

/* Check if MegaBook is running, if not, run it */
if ~show(’P’, ’MEGABOOK.01’) then do

address command
’run >nil: ’ MegaBookPath
/* Wait for the ARexx port */
do 5 while ~show(’P’, ’MEGABOOK.01’)

’sys:rexxc/waitforport MEGABOOK.01’
end

end

address ’MEGABOOK.01’
options results
--------- cut -------------------------------------------------------------

You should use this in all apart from the startup script (as that should
only be run by MegaBook).

You’re now free to do what you want in the script.

IMPORTANT NOTE: If MegaBook’s windows are locked, or a window or requester
is open (excluding the find and print windows) then the ARexx port WONT
work. As soon as the requester is gone, however, all arexx commands waiting
will be processed.

See the example scripts for more information on writing your own scripts and
some usefull code.

If you write a good script for MegaBook, we’d love to see it! Send it to us
and we may even put it in the next release of MegaBook!

1.24 3.5 Special Scripts

MegaBook 3 has some special ARexx scripts, some of which are ←↩
optional.

Please see section
4.1
for more information on the extras.

The other special script is the Startup.mbrx script which resides in your
MegaBook3:Rexx/ directory. This script is run when you start MegaBook.
This script is extremely usefull and can be fun too. For instance, you can
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use it to open your favourite database or possibly to password your copy
of MegaBook. A fun (sort of) example of the Startup.mbrx can be found with
the fortune cookies script provided.

1.25 4.1 Introduction

MegaBook 3’s Extras are unique to MegaBook. You won’t find them in ←↩
any other

Address Book program!

Put simply, the Extras take the grind away from doing regular things with
the database. They allow you to tone-dial your phone, call your friend’s
BBS, send a fax and even send an EMail. The extras are completely
customizeable to suit your system. It’s based partly around ARexx to allow
for a greater degree of flexibility. There’s a Storage directory with
scripts for the most used Terminal’s, Mailers and Fax software. Plus, if
there isn’t a script there that you need, simply EMail us and tell us what
you want and we’ll write it, and send you the script!

MegaBook 3’s installer can automatically set this up for you. If your
sofware isn’t in the list then you will have to create your own script.
See section

4.7
for more information on this.

1.26 4.2 Voice Dialing

Voice dialing is the ultimate extra for extremely lazy people. Simply hold
your phone’s mouthpiece to the speaker and select Dial Voice. It might take
a little while to get the volume right but once you have, MegaBook will dial
all your friends for you. Now you have no excuse for forgetting your mums
phone number!

The dialer is quite inteligent and wont let you dial if there isn’t a
voice number in the current record.

1.27 4.3 Data Dialing

Data dialing is a simple alternative to using your terminals phone book
facilities. Sort of anyway. Data dialing works a little like Voice dialing
except it uses a terminal program to dial.

Note: The script DialData.mbrx MUST be present in the MegaBook3:Extras/
directory. This script is installed by the installer from the storage dir.
There’s scripts for NComm, Term, Termite and ZeeTerm.

The script will run the terminal if it isn’t running already. Note that in
order for this to work, you must change the variable in the script to the
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path of the terminal. The comment in the script tells you what to do.

1.28 4.4 Sending Faxes

Fax sending works the same as Data Dialing. Unfortunately, we couldn’t get
hold of any ARexx port docs for any fax programs so you’ll have to write
your own. When the script is run, the Fax number is parsed in the command
line for you. The script name is SendFax.mbrx

1.29 4.5 Sending EMails

EMail sending is a little more complex then the dialing but not much.
The script this time is SendEmail.mbrx. Scripts have been provided for Spot
and Yam. In the Spot script, you’ll need to change the path to Spot and the
area name to post in. For the Yam script, you just have to change the
Editor. The comments in the scripts help you with this.

When the script is run, you’ll get the editor up and in Spots case, the
usual message header window. In Yam’s case the script does a little more as
it’s ARexx port isn’t as good as spot’s so the Script creates a text file
in RAM: and asks you for a subject. it then puts the message in Yam’s
outgoing queue.

1.30 4.6 Extras Storage

The Extras Storage drawer contains the scripts for the Extras menu. When
you install MegaBook 3, the installer automatically sets this part up for
you so you only need worry about this if you get a new Terminal or Mail
software.

1.31 4.7 Writing scripts

Writing your own Extras scripts is easy. MegaBook checks to see if ←↩
a

record has valid data for the action you’re trying to do and then runs
the script or pops up a requester.

When run, your script will be parsed the number/address in the command line.
Note that you don’t need to bother checking if MegaBook is running as you
should be run from MegaBook.

Have a look at the current scripts if you get stuck. The MegaBook ARexx
port is still available whilst a script is running if you need it.

If you write a good Extras script, we want it! Escpecially Fax ones.
See section

5.2
for where to send them.
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1.32 5.1 Credits

MegaBoook 3 has been produced by Eden Software and is © 1996 Eden Software.

Main code and scripts : Tom Bampton
Yam mailer script : Steve Clack
Scripts : Edward Farrow

Many thanks to all my beta testers too. There’s too many to mention here
but you know who you are!

1.33 5.2 Contacts

Contact me at Death Valley BBS on 01428 653471, 10PM - 8AM. You can also
register here.

For support or to submit an ARexx script for the next version, email
tombampton@dvalley.demon.co.uk or call the above BBS.

1.34 5.3 Eden Software

Eden Members List
~~~~~~~~~~~~~~~~~

This is the current eden members list with our EMail addresses.
If an email address isn’t listed, the person can be contacted thru the
eden@dvalley.demon.co.uk address if you specify Attn: <name> in the body
of the message at the top. E.G:

To: eden@aworld.demon.co.uk
From: Joe Bloggs
Subject: stuff

Attn: Steve Clack

rest of msg

If you aint in this list and wanna join, send a email to me at
eden@aworld.demon.co.uk or call me BBS and i’ll send u a member form.

Heres the list:

Name EMail
~~~~ ~~~~~
Tom Bampton eden@aworld.demon.co.uk
Steve Clack
James Johnston
Niki Murkett Niki_Murkett@Metnet.demon.co.uk
Spencer Jarvis Spencer_Jarvis@o14Amiga.Demon.Co.UK
Jimmy White jimmy@dcandy.demon.co.uk
Leigh Russ leigh.russ@aworld.demon.co.uk
Daniel Garnett
David Meagor DR.CRIPPLE@metnet.demon.co.uk
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Edward Farrow edward.farrow@ooh.dircon.co.uk

Distribution Sites
~~~~~~~~~~~~~~~~~~

Name Phone Hours
~~~~ ~~~~~ ~~~~~
Tom Bampton 01428 653471 10PM - 8AM
Steve Clack 01983 522548 24Hours
Jimmy White 0115 9112633 24Hours
Leigh Russ 01488-608698 24Hrs w/e only
Daniel Garnett 01243-373596 24Hrs

1.35 MegaBook.guide Index

MegaBook.guide Index

~1.1~Introduction~~~~~~~~~

~1.2~System~Requirements~~

~1.3~Legal~Stuff~~~~~~~~~~

~1.4~Registration~(Free!)~

~1.5~Distribution~~~~~~~~~

1.6 Installation

~1.7~Using~This~Guide~~~~~

1.8 Release Notes

~2.1~~The~First~Time~~~~~~

~2.2~~The~Windows~~~~~~~~~

~2.3~~Records~~~~~~~~~~~~~

~2.4~~Navigation~~~~~~~~~~

~2.5~~Loading~~~~~~~~~~~~~

~2.6~~Saving~~~~~~~~~~~~~~

~2.7~~Searching~~~~~~~~~~~

~2.8~~Printing~~~~~~~~~~~~

~2.9~~Preferences~~~~~~~~~

~2.10~Menus~~~~~~~~~~~~~~~

~3.2~Database~Commands~~~~
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~3.2~Requester~Commands~~~

~3.3~Example~Scripts~~~~~~

3.4 Writing scripts

3.5 Special Scripts

~4.1~Introduction~~~~~~~~~

~4.2~Voice~Dialing~~~~~~~~

~4.3~Data~Dialing~~~~~~~~~

~4.4~Sending~Faxes~~~~~~~~

~4.5~Sending~EMails~~~~~~~

~4.6~Extras~Storage~~~~~~~

4.7 Writing scripts

~5.1~Credits~~~~~~~~~~~~~~

~5.2~Contacts~~~~~~~~~~~~~

~5.3~Eden~Software~~~~~~~~

1.36 6.1 Them funny bugs no-one likes to talk about :)

This section has been written for a bit of a laff. Its just a list of funny
bugs that sprung up before MegaBook 3.2 was released but were fixed so no1
saw em :)

o Due to me being tired when i recoded the toolbar, i forgot to remove the
font adaptivity. This led to some funny side effects when the system font
wasn’t topaz :) We had mis-sized gadgets with the images staying the same
size and overlapping everything :)

o In another bout of stupidness i COMPLETELY forgot to call the iconify
handling code so when u iconified, nothing was checking for the close
gadget :) It took me a few hours to find what was wrong :((

o
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